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About This Manual

This manual contains introductory and installation information for your 

IMAQ Vision for LabVIEW Real-Time (RT) software and describes how to 

create a real-time vision application using IMAQ Vision for LabVIEW RT.

Conventions

The following conventions appear in this manual:

» The » symbol leads you through nested menu items and dialog box options 

to a final action. The sequence File»Page Setup»Options directs you to 

pull down the File menu, select the Page Setup item, and select Options 

from the last dialog box.

This icon denotes a tip, which alerts you to advisory information.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to 

avoid injury, data loss, or a system crash.

bold Bold text denotes items that you must select or click on in the software, 

such as menu items and dialog box options. Bold text also denotes 

parameter names.

italic Italic text denotes variables, emphasis, a cross reference, or an introduction 

to a key concept. This font also denotes text that is a placeholder for a word 

or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the 

keyboard, sections of code, programming examples, and syntax examples. 

This font is also used for the proper names of disk drives, paths, directories, 

programs, subprograms, subroutines, device names, functions, operations, 

variables, filenames and extensions, and code excerpts.

monospace bold Bold text in this font denotes the messages and responses that the computer 

automatically prints to the screen. This font also emphasizes lines of code 

that are different from the other examples.
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Related Documentation

The following documents contain information that you may find helpful as 

you read this manual:

LabVIEW Real-Time Documentation

• LabVIEW Real-Time User Manual

• LabVIEW Real-Time Release Notes

IMAQ Vision Documentation

• IMAQ Vision Concepts Manual

• IMAQ Vision for LabVIEW User Manual

• IMAQ Vision online help

IMAQ Vision Builder Documentation

• IMAQ Vision Builder Tutorial

• IMAQ Vision Builder online help

Other Documentation

• Your National Instruments IMAQ PXI device user manual

• Getting Started With Your IMAQ System

• NI-IMAQ User Manual

• Vision Deployment Engine Note to Users

• Your National Instruments PXI controller user manual
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1
Welcome to IMAQ Vision for 
LabVIEW Real-Time

This chapter introduces IMAQ Vision for LabVIEW Real-Time (RT) and 

describes how you can use its software components to create a machine 

vision application for a real-time, deterministic, embedded target.

About IMAQ Vision for LabVIEW RT

With IMAQ Vision for LabVIEW RT, you have all the tools you need to 

develop a complete machine vision application on a reliable, embedded 

platform. IMAQ Vision for LabVIEW RT features the image acquisition 

capabilities of IMAQ hardware and NI-IMAQ software, the real-time 

programming and execution capabilities of LabVIEW RT, the easy-to-use 

prototyping features of IMAQ Vision Builder, and the image manipulation 

and analysis tools of IMAQ Vision. Use these features to manage 

remote-location image acquisition and analysis from your host machine to 

create a reliable, embedded vision application.

You can develop your vision application with IMAQ Vision for LabVIEW 

RT, and then download that code to run on a real-time, embedded target. 

You can also add National Instruments DAQ, Motion Control, CAN, and 

serial instruments to your LabVIEW RT system, giving you the ability to 

create complete, integrated, embedded systems.

System Components and Requirements

Your IMAQ Vision for LabVIEW RT system consists of a development 

system and one or more deployed RT targets. See Figure 1-1 for an 

illustration of a complete IMAQ Vision for LabVIEW RT system.
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Development System
The development system is made up of two components—a Pentium-based 

host machine using a Windows operating system and a National 

Instruments PXI chassis housing a PXI controller. Use the host machine to 

configure your PXI controller as an RT target and to develop your 

application. Execute the application remotely on the PXI controller. 

The two machines communicate with each other over a network connection 

and use Measurement & Automation Explorer (MAX) to share 

configuration settings and software. Chapter 2, Install and Configure Your 

Development System, details how to set up each machine and how they 

interact with each other.

Note You will need a network connection during development to configure your RT target 

and download software and code from your host machine. A network connection is 

optional at runtime.

Pentium-Based Host Computer

Your host machine must meet the following minimum system 

requirements:

• Windows XP/2000/NT 4.0/Me/9x

• At least 233 MHz Pentium-class MMX processor

• 800 × 600 (or higher) resolution video adapter, using at least 

16-bit color

• Minimum of 64 MB RAM (128 MB recommended)

• Minimum of 50 MB of free hard disk space

• LabVIEW 6.1 or higher

• LabVIEW Real-Time Module 6.1 or higher

National Instruments PXI System

Select the PXI controller that best meets the needs of your application. 

Table 1-1 lists the different controllers you can use with IMAQ Vision for 

LabVIEW RT.
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National Instruments recommends the NI 8175 or NI 8176 for use with 

IMAQ Vision for LabVIEW RT.

Note The NI 8140 device does not support configuration because it does not boot into 

Windows, where you use MAX to configure your camera and acquisition device settings. 

If you choose to use an NI 8140 device as a deployed RT target, you must first use a 

controller that supports configuration to configure your camera and acquisition device 

settings, and then transfer those settings to your NI 8140 device as described in Chapter 2, 

Install and Configure Your Development System.

Your PXI system must also meet the following minimum system 

requirements:

• Windows XP/2000/NT 4.0/Me/9x

• Network adapter, floppy disk drive, keyboard and mouse

• National Instruments IMAQ PXI image acquisition device

• Analog or digital camera and associated cables

• LabVIEW RT run-time license

• IMAQ Vision for LabVIEW RT run-time license

Deployed System
Once you have configured your host development system, you can set up 

and configure additional LabVIEW RT targets for deployment. These 

deployed systems use the same hardware and software as your 

development LabVIEW RT target, and do not require Windows for 

configuration. 

Your deployed LabVIEW RT devices may be connected to the same subnet 

as your host development system, or you may connect them to a different 

subnet as required by your application. These connections are illustrated 

in Figure 1-1. Refer to Chapter 5, Additional Information About IMAQ 

Table 1-1.  National Instruments RT Series PXI Controllers

Device Functionality

NI 8175 or NI 8176 Supports full functionality

NI 8170 or NI 8156B Does not support PXI Video Out

NI 8140 RT Series Does not support PXI Video Out or 

configuration.
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Vision for LabVIEW RT, for more information about deploying remote 

systems.

Figure 1-1.  IMAQ Vision for LabVIEW RT System Components

Documentation and Examples

In addition to this manual, several documentation resources are available 

to help you create your vision application:

• IMAQ Vision for LabVIEW User Manual—Use this manual as a 

reference for using IMAQ Vision in LabVIEW.

• IMAQ Vision Concepts Manual—If you are new to machine vision 

and imaging, read this manual to understand the concepts behind 

IMAQ Vision.

• IMAQ Vision for LabVIEW online reference—If you need information 

about IMAQ Vision palettes or individual IMAQ Vision VIs while 

creating your application, refer to this help file. Access this file by 

selecting Help»IMAQ Vision from within LabVIEW.

• NI-IMAQ User Manual—Use this manual as a reference for using 

NI-IMAQ to acquire images from your IMAQ hardware.
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• Example programs—If you want examples of how to create specific 

applications, go to LabVIEW\Examples\Vision, or see the help file 

at Help»Search Vision Examples from within LabVIEW.

• Application Notes—If you want to know more about advanced 

IMAQ Vision concepts and applications, refer to the Application 

Notes located on the National Instruments Web site at 

ni.com/appnotes.nsf/.

• NI Developer Zone (NIDZ)—If you want even more information 

about developing your vision application, visit the NI Developer Zone 

at ni.com/zone. The NI Developer Zone contains example 

programs, tutorials, technical presentations, the Instrument Driver 

Network, a measurement glossary, an online magazine, a product 

advisor, and a community area where you can share ideas, questions, 

and source code with vision developers around the world.

Components of IMAQ Vision for LabVIEW RT 

IMAQ Vision for LabVIEW RT combines NI-IMAQ driver software, 

the IMAQ Vision processing library, and the IMAQ Vision Builder 

prototyping environment. IMAQ Vision for LabVIEW RT provides a 

comprehensive set of tools and VIs that allow you to quickly and easily 

create a reliable, embedded machine vision application.

National Instruments IMAQ Devices
National Instruments image acquisition (IMAQ) hardware and Vision 

software work in a seamless, integrated fashion with National Instruments 

data acquisition (DAQ) and motion control products. Many IMAQ devices 

feature the RTSI bus and the PXI trigger bus, which share timing signals 

across devices to synchronize and correlate images.

NI-IMAQ 
NI-IMAQ is a library of routines that work with National Instruments 

IMAQ devices. NI-IMAQ contains methods for performing tasks ranging 

from simple device initialization to advanced high-speed image 

acquisition. The services you need for your application depend on the types 

of IMAQ devices you have and the complexity of your application.

Note All NI-IMAQ functions are fully supported by IMAQ Vision for LabVIEW RT. 
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NI-IMAQ also includes a buffer manager that lets you simultaneously 

acquire and process data. NI-IMAQ uses direct memory access (DMA) 

to transfer all data to system memory.

NI-IMAQ Functions
NI-IMAQ enhances the performance of National Instruments IMAQ 

devices by allowing multiple devices to operate at their peak performance, 

and features both high-level I/O functions for maximum ease of use and 

low-level I/O functions for maximum flexibility and performance.

NI-IMAQ functions are grouped into three classes: generic, high-level, and 

low-level. Generic functions include the programming tasks required to set 

up an acquisition. High-level functions allow you to write programs 

quickly without having to learn the details of the low-level API and driver. 

The low-level functions give you greater control over your image 

acquisition process, but require a more detailed understanding of the API.

Generic Functions—Combine NI-IMAQ Generic functions with high- 

and low-level functions to perform common activities, such as opening and 

closing an interface or session. 

High-level Functions—Use high-level functions to quickly and easily 

capture images. If you need more advanced functionality, you can mix 

high-level functions with low-level functions. The high-level function set 

supports the following basic types of image acquisition:

• Snap acquires a single image to a buffer.

• Grab performs an acquisition that loops continually on one buffer; you 

obtain a copy of the acquisition buffer by grabbing a copy to a separate 

buffer that can be used for analysis.

• Sequence performs an acquisition that acquires a specified number of 

buffers, then stops.

The high-level function set also allows simple triggered acquisitions and 

the generation of external signals on the trigger lines.

Low-level Functions—Use low-level functions when you require more 

direct hardware control. The low-level function set supports all acquisition 

types. You can use low-level functions to perform the following tasks:

• Create and manage your own buffers

• Set session and interface attributes to adjust image quality and size

• Start a synchronous or asynchronous acquisition

• Extract buffers out of a live acquisition for analysis
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New Functionality in NI-IMAQ for LabVIEW RT
In addition to supporting all of the functionality of NI-IMAQ in 

LabVIEW RT, IMAQ Vision for LabVIEW RT introduces a new software 

utility. IMAQ Hardware Diagnostic, which is included in NI-IMAQ for 

LabVIEW RT, allows you to remotely run diagnostics on the hardware 

installed in your PXI chassis. Use IMAQ Hardware Diagnostic to verify 

your hardware installation as well as your target execution settings. You 

can also use this utility to test and diagnose your IMAQ devices from your 

host machine if you experience unexpected hardware errors. 

For more information about remotely testing your IMAQ hardware, refer 

to Chapter 2, Install and Configure Your Development System.

IMAQ Vision
IMAQ Vision software provides complete functionality for industrial 

machine vision and scientific image analysis. IMAQ Vision includes 

hundreds of functions for gauging and measurement, blob analysis, 

morphology, edge detection, filtering, image processing, and grayscale and 

color pattern matching.

IMAQ Vision helps you reduce both the cost and time-to-market of your 

imaging applications. Transparent memory management and high-level 

functions built to work together let you develop your application faster, and 

logically named VIs and parameters make IMAQ Vision easy to use.

IMAQ Vision functions are divided into three categories: Vision Utility, 

Image Processing, and Machine Vision functions.

Vision Utility Functions—The Vision Utility VIs allow you to create and 

manipulate images to suit your application’s needs. This category of 

functions includes image management and manipulation VIs, file 

management VIs, calibration, and region of interest and display VIs.

Image Processing Functions—You can use IMAQ Vision’s Image 

Processing VIs to analyze, filter, and process your images according to the 

needs of your application. These VIs include functions for analysis, color 

processing, frequency processing, filtering, morphology, operations, and 

processing, including the IMAQ Histogram, IMAQ Threshold, and IMAQ 

Morphology VIs.

Machine Vision Functions—Use the Machine Vision VIs to perform 

common machine vision inspection tasks, including checking for the 

presence or absence of parts in an image and measuring the dimensions of 
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parts to see if they meet specifications. Some examples of machine vision 

VIs are Caliper VIs and Coordinate System VIs.

Note A small number of IMAQ Vision VIs are not supported under IMAQ Vision for 

LabVIEW RT. Refer to Appendix A, Troubleshooting, for a list of these VIs.

New Functionality in IMAQ Vision for LabVIEW RT
IMAQ Vision for LabVIEW RT introduces two new options for displaying 

your images: Remote Display and PXI Video Out. These features are 

accompanied by two new VIs—IMAQ Remote Compression and IMAQ 

Video Out Display Mode. 

IMAQ Remote Compression allows you to configure the method and level 

of compression for images displayed remotely on your host machine. 

IMAQ Video Out Display Mode allows you to programmatically set the 

display mode for the PXI Video Out on your remote LabVIEW RT system. 

Refer to Chapter 4, Display Your Images in IMAQ Vision for LabVIEW RT, 

for more information about displaying your images in IMAQ Vision for 

LabVIEW RT and the new display VIs.

IMAQ Vision Builder
Use IMAQ Vision Builder to acquire your first remote images from your 

LabVIEW RT system, and then prototype and test image processing 

applications on those images. To prototype your image processing 

application, build custom algorithms with the IMAQ Vision Builder 

scripting feature. The scripting feature records every step of your 

processing algorithm. After completing the algorithm, you can test it on 

other images to check its reliability.

Using the LabVIEW VI creation wizard, you can create a LabVIEW VI that 

implements the prototype you created in IMAQ Vision Builder. You can 

then run this VI on your host machine or on your remote LabVIEW RT 

target.

IMAQ Vision Builder makes prototyping easy, with features including a 

script window where you can record each step in your application and a 

reference window that houses your original image.

To learn more about prototyping IMAQ Vision applications in IMAQ 

Vision Builder, refer to the IMAQ Vision Builder Tutorial, which contains 

several interactive examples.
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New Functionality in IMAQ Vision Builder for 
LabVIEW RT
A new remote acquisition module in IMAQ Vision Builder allows you 

to acquire images from remote LabVIEW RT systems. You can then 

manipulate those images in IMAQ Vision Builder to prototype applications 

and solutions.
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2
Install and Configure Your 
Development System

This chapter details each of the steps necessary for setting up your IMAQ 

Vision for LabVIEW Real-Time (RT) development system. These steps 

include setting up and configuring your PXI system, preparing your host 

machine, and downloading software from your host machine to your PXI 

system. Consult your hardware- and software-specific documentation if 

you have further installation or functionality questions. 

Tip Before you begin, locate the following documents to use as references during the 

installation process:

• LabVIEW User Manual

• LabVIEW Real-Time User Manual

• LabVIEW Real-Time Release Notes

• Your National Instruments IMAQ PXI device user manual

• Your National Instruments PXI controller user manual

What You Need to Get Started

You will need the following items to set up your IMAQ Vision for 

LabVIEW RT system:

❑ This manual and all related IMAQ and LabVIEW RT documentation

❑ Your Pentium-class host PC with network connections

❑ Your PXI controller with keyboard, mouse, and monitor

❑ Your National Instruments IMAQ PXI device

❑ Camera and associated cables

❑ IMAQ Vision 6.1 Development Module for LabVIEW installation CD
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❑ Two floppy disks

❑ CAT-5 crossover cable, if your PXI controller is not connected to a 

network

Table 2-1 illustrates the requirements and components of each part of your 

IMAQ Vision for LabVIEW RT system—your host machine and your 

remote PXI chassis.

Table 2-1.  Host and Remote System Requirements

Requirement Host Remote

Hardware Refer to Chapter 1, Welcome to 

IMAQ Vision for LabVIEW 

Real-Time, for the minimum 

system requirements for your host 

machine.

National Instruments PXI 

controller (Refer to Table 1-1, 

National Instruments RT Series 

PXI Controllers, for specific 

controller information)

National Instruments IMAQ PXI 

image acquisition device

Analog or digital camera and 

associated cables

Operating System Windows XP/2000/

NT 4.0/Me/9x

Windows XP/2000/NT 4.0/Me/9x 

for configuration

LabVIEW RT run-time kernel 

(after booting up from PXI boot 

disk) for software development 

and execution

Software LabVIEW 6.1 or higher

LabVIEW Real-Time 6.1 or higher

IMAQ Vision for LabVIEW 

Real-Time

NI-IMAQ 2.5.1 or higher

Licensing Your IMAQ Vision license is 

included with your purchase of 

IMAQ Vision for LabVIEW RT.

You must purchase an IMAQ 

Vision for LabVIEW RT run-time 

license and a LabVIEW RT 

run-time license for your remote 

RT system and each deployed RT 

system. Visit ni.com for more 

information on purchasing 

run-time licenses.



Chapter 2 Install and Configure Your Development System

© National Instruments Corporation 2-3 IMAQ Vision for LabVIEW RT User Manual

Set Up Your Host PC

Your host machine serves as the command center for your LabVIEW RT 

system. Follow these steps to set up and configure your host machine:

1. Install LabVIEW from the LabVIEW installation CD. The installation 

program, autorun.exe, launches automatically when you load 

the CD.

2. Install LabVIEW RT. The installation program, autorun.exe, 

launches automatically when you load the CD.

Note If you are using a machine running Windows 2000/NT/XP, you must log on as an 

administrator or as a user with administrator privileges in order to install LabVIEW RT.

3. Insert your Vision installation CD into your CD-ROM drive.

Loading the CD-ROM launches autorun.exe, which begins the 

installation process. Follow the on-screen directions to install all of the 

components of IMAQ Vision for LabVIEW RT. 

Create Your Configuration Disk
Installing IMAQ Vision for LabVIEW RT installs a utility named 

ConfigureIMAQRT.exe on your host machine. The following steps 

describe how to copy this utility onto a floppy disk for use later in the setup 

process:

1. Insert one of your blank floppy disks into the A:\ drive of your host 

machine.

2. Browse to your <ni-imaq>\bin directory.

3. Select ConfigureIMAQRT.exe, and copy the file onto your 

floppy disk.

4. Remove the disk from your floppy drive and label it Configure 

IMAQ RT.
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Create Your PXI Boot Disk
You now have all of the necessary components installed on your host 

machine, and you are ready to create a boot disk that you can use to boot 

your PXI controller into LabVIEW RT.

1. Close any open Windows Explorer windows.

2. From your host machine, open MAX and select Tools»Remote 

Systems»Disk Utilities»Create PXI Boot Disk.

3. Insert your second blank floppy disk into the A:\ drive of your host 

machine and click Make Boot Disk.

Note Do not use the same floppy disk that you used for the Configure IMAQ RT utility.

4. Remove the disk from your floppy drive and label it “PXI Boot Disk.”

In the next section you will install your IMAQ device.

Prepare Your PXI Chassis for Image Acquisition

The next step in setting up your LabVIEW RT system is to install your 

IMAQ hardware and prepare your PXI chassis for image acquisition.

You will use Windows on your PXI controller to configure your IMAQ 

device and camera. When you are ready to develop and execute your 

application, you will boot your controller into LabVIEW RT using the boot 

disk you created in the last section.

1. Power on your PXI controller. The system boots into Windows.

Note You must boot your PXI controller into Windows in order to configure your device 

and camera. If Windows is not already installed on your PXI controller, refer to 

Appendix A, Troubleshooting, for more information.

Note If you purchased your IMAQ PXI image acquisition device and PXI controller at the 

same time, your IMAQ image acquisition device and NI-IMAQ software may already be 

installed on your PXI controller. If you have MAX installed, use MAX to detect whether 

you have the required version of NI-IMAQ installed by clicking the Software folder under 

My System. If MAX detects that you have the required version of NI-IMAQ installed, 

proceed to the next step: Check Your Camera Settings With Measurement & Automation 

Explorer.

2. Locate the installation CD that was included in your IMAQ hardware 

shipment, and install NI-IMAQ according to the on-screen directions.
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Install Your IMAQ Device

Caution Make sure that your PXI controller is off and unplugged before beginning your 

hardware installation.

1. Select an unused PXI 5 V peripheral slot. Install your IMAQ device in 

a slot that supports bus arbitration or bus-master cards. PXI-compliant 

chassis must have bus arbitration for all slots.

2. Remove the filler panel for the peripheral slot you have chosen.

3. Touch a metal part on your chassis to discharge any static electricity 

that might be on your clothes or body.

4. Insert your IMAQ device into the selected 5 V slot. Use the 

injector/ejector handle to fully inject the device into place.

5. Screw the front panel of your IMAQ device to the front panel mounting 

rails of the PXI chassis.

6. Visually verify the installation.

7. Replace the power cord and power on your PXI chassis.

8. Connect your camera to your IMAQ device with the appropriate cable. 

Figure 2-1.  Installing Your IMAQ Device

1 PXI Controller and Chassis
2 National Instruments IMAQ PXI device

3 Ejector Handle in the Down Position
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Tip For detailed information on installing this device, including unpacking and safety 

information, see your hardware device-specific documentation.

Your remote system is now equipped for image acquisition.

Check Your Camera Settings With 
Measurement & Automation Explorer

Use MAX to modify your camera and device properties.

1. Power on your PXI controller. You will modify these properties in 

Windows.

2. Launch MAX by double-clicking the icon on your desktop.

3. Expand Devices and Interfaces to reveal a list of your installed IMAQ 

devices. Select your IMAQ device from the list.

4. Click the Diagnostic button on the toolbar to open the diagnostics 

window, and click Run Tests to run the diagnostics tests on your 

IMAQ device.

5. Click the Properties button on the toolbar to view or modify the 

configuration.

6. Click the + next to your IMAQ device to display a list of the available 

channels.

7. Right-click on one of the channels to obtain a list of camera types. 

8. Choose the appropriate camera type from the list. The types of cameras 

available vary according to your IMAQ device.
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9. Click Properties to view or modify the camera files.

Note If you are using a digital camera that is not listed in MAX, you must go to 

ni.com/cameras to download the appropriate camera file.

Note the interface name associated with your camera. You will refer to 

your acquisition device later using this interface name. MAX specifies 

img0 as the default interface name.

10. When you are satisfied with your property settings, click OK to close 

the window. You are now ready to perform an acquisition.

11. In MAX, right-click on the channel associated with your camera and 

select Grab. 

A live video image opens in your MAX window. Take this opportunity 

to focus your camera, adjust its position, and set up your lighting. 

Manipulate each of these options until you achieve satisfactory image 

conditions.

12. When you are satisfied with your image conditions, click the Grab 

button to stop the acquisition, and exit MAX.



Chapter 2 Install and Configure Your Development System

IMAQ Vision for LabVIEW RT User Manual 2-8 ni.com

Transfer Your RT Configuration Settings

Now that you have configured your camera settings in MAX, use 

Configure IMAQ RT.exe, which you created earlier in the setup process, 

to transfer those settings to the RT portion of your system. Refer to the 

Configure Your PXI Controller as a Remote Device section of this chapter 

for more information about this executable file.

1. Close MAX.

2. Insert the floppy disk labeled “Configure IMAQ RT” into the A:\ drive 

of your PXI controller.

3. Copy the file onto your desktop.

4. Double-click the file to run the application.

Note Whenever you use MAX to change your configuration settings in Windows, you 

must run this executable again in order to update your RT configuration to reflect those 

changes.

Configure Your PXI Controller as a Remote Device

This section describes how to boot your PXI controller into RT and how to 

name and locate the remote device on your network.

LabVIEW RT lets you provide a unique host name and IP address for your 

remote device. To set up your network configuration, your remote device 

must be installed on the same network subnet as your host machine.

Note If your remote device is not installed on the same network subnet as your host 

machine, use a CAT-5 crossover cable to connect your system.

1. Insert the PXI boot disk into the A:\ drive. 

2. Shut down Windows and reboot the PXI chassis. 

The controller boots up into a text screen displaying the IP address of the 

remote device. Notice that the IP address is currently 0.0.0.0.

Note If your controller booted up into Windows, you will need to edit your BIOS boot 

settings to instruct the controller to boot from your floppy drive. Refer to Appendix A, 

Troubleshooting, for more information.



Chapter 2 Install and Configure Your Development System

© National Instruments Corporation 2-9 IMAQ Vision for LabVIEW RT User Manual

3. Return to your host machine, and open MAX from your host machine. 

Double-click Remote Systems in the left pane to expand the list of 

available LabVIEW RT targets.

4. Select your PXI controller, which is listed by its serial number.

5. Click the Network Settings tab at the bottom of the right pane. 

The Device ID and IP Settings window opens. Use this window to 

define the host name and IP address for your host system.

6. Specify a unique host name and an IP address. 

You may assign an IP address using one of these methods:

• Select Obtain IP Address from DHCP server to have the DHCP 

server on your network allocate an IP address to your PXI 

controller each time the PXI controller is booted.

• Select Edit the IP Settings to enter a predetermined IP address 

and configure the Subnet Mask, Gateway, and DNS Address 

network parameters for your PXI controller.

Tip Contact your network administrator if you need additional assistance in configuring 

your remote device on your network.

7. Click Apply. The network settings for your remote device are now 

saved.

8. Click Yes when MAX prompts you to reboot your remote device.

When the remote system reboots, the designated IP address appears in the 

right pane of MAX. The status message Connected – No software 

installed appears in the bottom right corner of the MAX window, 

indicating that you have configured your PXI controller correctly and that 

you are connected to the network.
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Remotely Install Your IMAQ Vision for LabVIEW RT 
Software

Use MAX to install NI-IMAQ RT and IMAQ Vision RT from your host 

machine onto your target system. These components enable your remote 

device to acquire and analyze images as directed by your host machine.

1. Click the Software tab at the bottom of the right pane in MAX. 

2. Right-click anywhere in the right pane and select Install Software. 

The right pane displays all of the software that is installed on your host 

machine and remote device, and provides version information for each 

component. Use this list to select the components that you want to 

transfer from your host machine to your remote device.
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3. Select the following software components—IMAQ Vision RT, 

LabVIEW RT, and NI-IMAQ RT. 

Note If your application requires any additional software components, you may also 

select them at this time. 

4. Click OK.
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Note MAX prompts you that the software updates will overwrite existing software and 

requests confirmation before beginning the installation. Click Yes to proceed.

MAX reboots the PXI controller and installs the software that you selected. 

You can monitor the progress of the transfer in the dialog box that opens in 

the center of the MAX window. 

Remotely Test Your IMAQ Hardware

Before you begin developing your IMAQ Vision for LabVIEW RT 

application, you should test the IMAQ hardware you installed in your RT 

chassis to ensure that all of your devices are installed correctly. This test is 

also your first test of running a LabVIEW RT-based IMAQ application on 

your remote system.

1. Launch LabVIEW from your host machine. 

2. Select Switch Execution Target from the LabVIEW launch screen or 

select Operate»Switch Execution Target. The target platform 

selection dialog opens.

3. Select RT Engine on Network from the drop-down list.

4. Enter the IP address of your remote target.

5. Click OK. LabVIEW closes all open VIs and returns to the startup 

screen.

The network address of your PXI controller is displayed in the bottom 

left corner of the LabVIEW RT window. This verifies that the target 

execution is configured properly.

6. Click Open VI.

7. Browse to <ni-imaq>\bin\imaqdiag.llb\IMAQ Hardware 

Diagnostic.vi.

8. Run the VI. Save the VI if prompted. LabVIEW RT indicates that it is 

downloading the VI and will run the VI when the download is 

complete. 

The VI detects the hardware installed in your PXI chassis, and displays 

the results in the Detected Interfaces listbox on the front panel.
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9. Select the name of the device you want to test and click Run Test. You 

can view the results of each test in the Test Results dialog box on the 

front panel.

10. Click Stop after you have run diagnostics on each of the hardware 

devices installed in your PXI chassis.

In the next chapter, you will learn how to perform these IMAQ Vision for 

LabVIEW RT tasks:

• Acquire, process, and analyze an image in IMAQ Vision Builder

• Create a LabVIEW RT VI based on the processing algorithms you 

used in IMAQ Vision Builder

• Run your LabVIEW RT VI on your remote system
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3
Develop Your IMAQ Vision for 
LabVIEW RT Application

This chapter describes how you can use IMAQ Vision Builder to acquire 

images from a remote LabVIEW Real-Time (RT) target device, prototype 

and test your own image processing algorithms, and then create LabVIEW 

VIs to run on your LabVIEW RT target device.

IMAQ Vision Builder is a tool for prototyping and testing image processing 

applications. Build custom algorithms with the IMAQ Vision Builder 

scripting feature to test your image processing application. The scripting 

feature records every step of your processing algorithm. After completing 

the algorithm, you can test it on other images to evaluate its performance.

IMAQ Vision Builder can generate a builder file from your image 

processing script. Builder files are ASCII text files that list the processing 

functions and relevant parameters for an algorithm that you prototype in 

IMAQ Vision Builder. Using the LabVIEW VI Creation Wizard, you can 

create a LabVIEW VI from that builder file that performs the steps you 

prototyped in IMAQ Vision Builder. You can then run this LabVIEW VI on 

your remote LabVIEW RT device, or modify it by adding your own 

additional functionality.

Launch IMAQ Vision Builder

1. From your host machine, open IMAQ Vision Builder 

(Start»Programs»National Instruments IMAQ Vision Builder). 

2. Click Acquire Image.

The Acquisition Module drop-down list shows the several different 

modules you can use to acquire images—the simulation module, the 

National Instruments IMAQ acquisition module, and the National 

Instruments IMAQ Remote acquisition module.

3. Select National Instruments IMAQ Remote from the Acquisition 

Module drop-down list. 

4. Click the IMAQ Remote tab.
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5. Enter the IP address or unique machine name for your remote device 

in the Remote Address field. Use the IP address or machine name that 

you configured for your remote target in Chapter 2, Install and 

Configure Your Development System.

6. If the PXI controller is locked, enter the system configuration 

password. 

Note The system configuration password is set in MAX, and is used to lock the 

configuration and reset of a remote system. (Refer to your RT Series PXI QuickStart Guide 

for details about locking a controller.)

7. Enter the interface name. Use the same interface name you entered 

during setup.

You are now ready to acquire your first remote image.

Acquire an Image

Now that you have finalized your remote camera settings and your remote 

device is configured on your network, you are ready to acquire an image 

directly into IMAQ Vision Builder.

1. Click Acquire Single Image. The acquired image is displayed in the 

right window of IMAQ Vision Builder. 

2. Click Acquire Continuous Image to acquire a continuous stream of 

images from your remote RT target.

3. Click Acquire Continuous Image again to stop the acquisition.

The next step explains how to compress your acquired images to improve 

the transfer time for moving images between your remote target and your 

host machine.

Configure Your Compression Settings

When you display images that you acquired on your remote machine, 

LabVIEW must send those images over your network. This transfer can 

take up a large amount of your network bandwidth, especially for large 

images. The IMAQ Vision Builder remote acquisition module allows you 

to compress those images to limit the network bandwidth used by the image 

acquisition process. You can enable compression and specify your image 

quality in the Parameters tab.
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1. Click the Parameters tab.

2. Select the Compression check box if you want to compress your 

images for display.

3. Enter an image quality score between 0 and 1000.

Lower values correspond to images with higher compression but lower 

image quality due to compression artifacts. Higher values correspond 

to images with less compression but better image quality due to fewer 

compression artifacts. Images with a quality of 1000 undergo no 

compression and have no compression artifacts.

Note Your compression settings only affect continuously acquired images that are 

transferred across your network for display on your host machine. Compression is not 

enabled for single image acquisition.

4. Click Acquire Continuous Image again to acquire images from your 

remote target.

5. Click Return when you have an acceptable image. You will be 

prompted to store your image in the Image Browser. Click Yes to 

accept.

Now use IMAQ Vision Builder to analyze and process your acquired 

image.

Process Your Image

As you apply various machine vision and image processing functions to 

your image, each step is saved in a script. You can view the current script 

in the Script Window. You can then create a LabVIEW VI from your 

script and run that VI on your remote PXI controller.

The following steps demonstrate some of the image processing operations 

you can perform on your image with IMAQ Vision Builder. See your IMAQ 

Vision Builder Tutorial for more information on using IMAQ Vision 

Builder.

1. Double-click on your image in the image browser.

Your image opens in the center of your IMAQ Vision Builder window. 

This large window is the Processing Window. Your original image is 

displayed in the Reference Window. You can return to this original 

image at any time by clearing your script with the New Script button 

or by clicking Begin in the script listbox.



Chapter 3 Develop Your IMAQ Vision for LabVIEW RT Application

IMAQ Vision for LabVIEW RT User Manual 3-4 ni.com

2. Select Grayscale»Filters.

Note If you acquired a color image, the Filters menu item is grayed out. For the purposes 

of this example, convert your image to grayscale by selecting Color»Extract Color 

Planes and selecting HSL-Luminance Plane before performing step 2.

Filters can smooth, sharpen, transform, and remove noise from an 

image so that you can extract the information you need. To sharpen 

edges, including the edges of any holes inside a particle, and create 

contrast between the particles and the background, follow these steps:

3. Select Convolution-Highlight Details from the Filters list. 

This function looks for sharp transitions and highlights edge pixels 

according to a kernel to make gaps more prominent. A kernel is a 

structure that represents a pixel and its relationship to its neighbors. 

Refer to your IMAQ Vision Concepts Manual for more information 

about kernels.

You can change the size of the kernel used for the filter in the 

Processing Window, which is located just beneath your image. Try 

setting your filter size to each of the kernel sizes—3 × 3, 5 × 5, and 

7 × 7—to view the different levels of detail you can achieve with this 

function.

4. When you are satisfied with your filter operation, click Apply. 

The Filters: Convolution - Highlight Details step is now listed in 

your script. To make changes to any step in the script, double-click on 

that step.

5. Click Close.

Note Remember that all IMAQ Vision Builder image-processing functions are accessible 

through the menu bar at the top of the screen. 
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Create a LabVIEW VI from Your 
IMAQ Vision Builder Script

Now use IMAQ Vision Builder to automatically create a VI based on your 

script.

1. Select Script»Create LabVIEW VI. The LabVIEW VI Creation 

Wizard opens.

Tip See your IMAQ Vision Builder documentation for more information on the 

LabVIEW VI Creation Wizard.

2. Select Current Script as the script you want to use to create your VI. 

Click Next.

3. Select Image Acquisition Board as your image source, and Snap as 

your acquisition type. Click Next.

The next screen in the wizard allows you to choose which parameters 

should appear as controls and indicators on your front panel. If an item 

in the left column is selected, it appears as a control in LabVIEW. 

Similarly, if an item is selected from the right column, it appears as an 

indicator in LabVIEW.

4. Click Finish to complete the LabVIEW VI Creation Wizard.

When you click Finish, LabVIEW launches and displays the front panel 

and block diagram of the VI you created in IMAQ Vision Builder.

You can now download and run your VI on your remote LabVIEW RT 

target. 

Run Your VI in LabVIEW RT on Your Remote Target

1. In LabVIEW, select File»Save to save the VI you created in IMAQ 

Vision Builder.

2. Select Operate»Switch Execution Target. The target platform 

selection dialog opens.

3. Select RT Engine on Network from the drop-down list.

4. Enter the IP address and machine name of your remote target.
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5. Click OK. LabVIEW closes all open VIs and returns to the startup 

screen.

The network address of your PXI controller is displayed in the bottom 

left corner of the LABVIEW RT window.

6. Open your saved VI. 

Note Ensure that the interface name on your front panel or diagram matches your intended 

remote interface. IMAQ Vision Builder specifies img0 by default.

7. Click Run. Your VI executes as soon as LabVIEW finishes 

downloading it to the remote target. 

Notice that your image is displayed on your host machine. You will learn 

more about display options in IMAQ Vision for LabVIEW RT in the next 

chapter, Display Your Images in IMAQ Vision for LabVIEW RT.
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4
Display Your Images in 
IMAQ Vision for LabVIEW RT

IMAQ Vision for LabVIEW Real-Time (RT) gives you two options for 

displaying your images: Remote Display and PXI Video Out. Choose the 

display option that best fits the needs of your application.

Use Remote Display during development and debugging to view your 

images from your host machine just as you would view the LabVIEW front 

panels of the VIs running on your RT system. Use PXI Video Out to display 

your images on a monitor connected to your remote LabVIEW RT system.

Remote Display

IMAQ Vision for LabVIEW RT includes a Remote Display feature that 

allows you to acquire images on your remote system and view them on your 

host machine. Remote Display is automatically enabled when you use any 

of the IMAQ Vision display VIs with IMAQ Vision for LabVIEW RT, 

such as IMAQ WindDraw, IMAQ ShowTools, and IMAQ Construct ROI. 

Remote Display is useful for monitoring and debugging your IMAQ Vision 

for LabVIEW RT applications. Familiarize yourself with how Remote 

Display works before using this feature. The following details will help you 

prepare your application for use with Remote Display:

• Remote Display is a front-panel feature. Therefore, your LabVIEW 

front-panel must be open for you to see images displayed using 

Remote Display.

• Remote Display performs best when combined with IMAQ Remote 

Compression. When you display images on your remote machine, 

LabVIEW must send those images over your network. This process 

can take up a large amount of your network bandwidth, especially 

when transferring large images. IMAQ Remote Compression allows 

you to specify compression settings for those images to reduce the 

network bandwidth used by the display process. In addition, 

compressing images may increase your display rates on slower 

networks. 
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• IMAQ Remote Compression uses two types of compression 

algorithms. The first is a lossy JPEG compression algorithm. This 

method works best on non-binary images. You can also use a lossless 

Packed Binary compression algorithm for binary images. See your 

IMAQ Vision VI Reference help for more information on the IMAQ 

Remote Compression VI. 

Note JPEG Compression may result in data degradation of the displayed image. There is 

no degradation of the image during processing. Test various compression settings to find 

the right balance for your application.

• Using Remote Display can affect the timing performance of your 

IMAQ Vision VIs. Do not use Remote Display if your program 

contains a time-critical loop.

• Disconnecting your remote system from your host machine disables 

Remote Display. Disabled Remote Display VIs do not affect the 

performance of your application. When you reconnect LabVIEW RT 

and your host machine, Remote Display is automatically re-enabled.

Tip Refer to the Remote Display Errors section in Appendix A, Troubleshooting, 

for more information about Remote Display.

PXI Video Out

PXI Video Out allows you to display images on a monitor that is connected 

to your PXI controller. To access this feature, input 15 for the Window 

Number parameter in the IMAQ WindDraw VI.

Note This feature is only available on PXI controllers that feature the i815 chipset, such 

as the National Instruments PXI-8175/76 Series controllers.

PXI Video Out also supports overlay functionality. Overlay text is limited 

to one size and one font.

This display option is not a time-bounded operation. For more information 

about time-bounded operations, refer to Chapter 5, Additional Information 

About IMAQ Vision for LabVIEW RT.

To programmatically configure your system to use PXI Video Out to 

display system images, use the IMAQ Video Out Display Mode VI. This 

VI allows you to set parameters for screen area, color depth, and refresh 

frequency.
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Tip Try the HL Grab (Video Out) or the Video Setup example for a demonstration of 

interactively setting your PXI Video Out display mode.

IMAQ WindDraw and IMAQ WindClose are the only IMAQ Vision 

display functions that support PXI Video Out. To use these VIs with PXI 

Video Out, you must specify Window Number 15.



© National Instruments Corporation 5-1 IMAQ Vision for LabVIEW RT User Manual

5
Additional Information About 
IMAQ Vision for LabVIEW RT

This chapter provides valuable information about using IMAQ Vision for 

LabVIEW Real-Time (RT) and describes some basic elements of real-time 

systems, including determinism and time-bounded algorithms. 

Determinism

Real-time determinism measures the consistency of a specified time 

interval between events. Deterministic behavior is often required for 

control algorithms, which must also be time-bounded. A time-bounded 

application is a routine that predictably executes within a known amount of 

time, regardless of initial conditions. A routine is not time-bounded if its 

execution time depends on input parameters or an initial state.

A real-time operating system, such as the one used to power the embedded 

RT engine, does not explicitly guarantee completely deterministic 

applications. However, programming choices and function characteristics 

can render an application time-bounded.

Determinism in IMAQ Vision for LabVIEW RT

IMAQ Vision for LabVIEW RT VIs can be divided into two categories of 

determinism—VIs that are never time-bounded and VIs that can be made 

time-bounded by applying the programming techniques discussed in this 

chapter.

When designing a LabVIEW RT application with IMAQ Vision for 

LabVIEW RT, try to use time-bounded image processing routines that 

execute deterministically to ensure that two calls to the same routine do not 

vary in overall execution time. In cases where it is not possible to use 

time-bounded image processing routines, benchmark the performance of 
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your application on a large set of sample images in order to obtain an 

approximate execution time. Most applications achieve the necessary level 

of consistency and reliability by combining the properties of a deterministic 

operating system with data from the sample set.

Parallel Processing in LabVIEW RT
LabVIEW passes images by reference, meaning that splitting an image 

wire creates a new reference to an existing image. IMAQ Vision locks 

images while you are processing them in order to prevent operations on 

different wires, or reference images, from interfering with each other. 

IMAQ Vision then waits until the image is available for processing, or 

“unlocked,” before running the function. This feature makes any IMAQ 

Vision VIs that use images unbounded, since parallel operations may cause 

these functions to wait for varying amounts of time. 

You can avoid this behavior by configuring your application to process 

images sequentially rather than in parallel.

Memory Allocation in LabVIEW RT
Any operation that must allocate memory is inherently unbounded since the 

time required to allocate memory is determined by the state of your system. 

Therefore, any function that must resize image data, such as IMAQ 

SetImageSize, is unbounded. 

Many IMAQ Vision VIs take an optional destination image. Often, these 

functions resize your destination image to match the size of your source 

image. For these VIs, pre-allocate the size of the destination image to match 

that of the source image before reaching the time-critical portion of your 

application.

Image Size Considerations
Some IMAQ Vision VIs, such as IMAQ Threshold, are time-bounded on 

the assumption that the image size remains constant throughout the 

application and that no other operations are using the same image in 

parallel. Since many of these algorithms process images acquired by a 

single sensor, the image size is consistent throughout the application.
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Acquisition VIs
IMAQ Vision’s acquisition VIs are time-bounded when the application 

meets the following criteria:

• The destination image does not require resizing

• Your camera is connected to your system and is working properly

• No other significant traffic is moving across your PXI bus

File I/O and Display VIs
File I/O and display VIs are inherently unbounded. However, Remote 

Display VIs become time-bounded when your target device is disconnected 

from your host machine, since remote display requires a connection with 

the host. Refer to Chapter 4, Display Your Images in IMAQ Vision for 

LabVIEW RT, for more information about Remote Display functionality.

Data Driven VIs
Image processing VIs that are completely data-driven are never 

time-bounded. A number of IMAQ Vision algorithms, such as pattern 

matching, color matching, edge detection, particle analysis, and some 

morphology operators fall into this category because their execution times 

depend on the content of the input image. For these algorithms, the 

execution time varies from image to image.

For example, IMAQ Basic Particle detects binary particles in an image. 

Its execution time depends on the contents of each image—the number of 

particles, their sizes, and their relative positions. Because images vary 

greatly in their contents, these types of VIs cannot be time-bounded.

Image Files

Many applications require you to use external files, such as the template 

files used by pattern matching and spatial calibration functions. Before 

running your external application on your remote target, you must use FTP 

to transfer any external image files from your host machine to your remote 

target. For more information about using FTP, refer to your LabVIEW 

Real-Time User Manual.
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Deployment

Once you have finished developing your IMAQ Vision for LabVIEW RT 

application, you may want to deploy that application to a number of remote 

systems. In order to achieve consistent results from your IMAQ Vision for 

LabVIEW RT application, you must configure these deployed systems 

with the same settings you used for your development system. 

Note Each deployed system must have its own RT Series PXI controller and software. 

Visit ni.com for ordering information.

One configuration option is to boot each deployed system into Windows 

and configure them manually using MAX in the same manner as you 

configured your development system. However, this option requires that 

you have Windows installed on each of your deployed remote targets.

Another configuration option is to use the FTP utility that is built into 

LabVIEW RT. IMAQ Vision for LabVIEW RT lets you simply copy your 

configuration settings to your RT controllers using FTP—eliminating the 

need to individually reconfigure your deployed cameras and IMAQ 

hardware in Windows. 

Note You must purchase an IMAQ Vision for LabVIEW RT run-time license and a 

LabVIEW RT run-time license for each deployed IMAQ Vision for LabVIEW RT system. 

Refer to ni.com for more information about purchasing run-time licenses.

Use the same installation procedures you used to set up your development 

target device to set up your deployed systems. For detailed information 

about each of these steps, refer to Chapter 2, Install and Configure Your 

Development System.

1. Install your IMAQ device.

2. From your host machine, use MAX to install LabVIEW RT, NI-IMAQ 

RT, and IMAQ Vision RT on each deployed target device.

You are now ready to copy your configuration settings.

3. From your host machine, use FTP to copy the contents of the 

C:\ni-imaq\data directory from development RT target to the same 

folder on your host machine.

4. Use FTP to transfer the contents of this folder from your host machine 

to the same directory on your deployed target device.
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Note Refer to your RT Series PXI/Compact PCI User Manual for more information about 

using FTP with your PXI controller.

Once your configuration settings are copied to your deployed target device, 

use LabVIEW RT to download your application to your controller. For 

more information about this process, refer to your LabVIEW Real-Time 

User Manual.
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A
Troubleshooting

This appendix describes solutions and suggestions for common errors in 

IMAQ Vision for LabVIEW Real-Time (RT).

PXI Controller Errors

What if I don’t have a PXI chassis and controller?

Please contact your local NI sales representative. 

Why can’t Measurement & Automation Explorer find my PXI 

controller?

Try the following techniques if your PXI controller does not appear in 

Measurement & Automation Explorer:

• When configuring the PXI controller, ensure that the controller is 

located on the same subnet of your network as the host PC. If you are 

unsure of your network configuration, consult your network 

administrator for assistance.

• If you do not have a keyboard connected to the PXI controller, check 

the BIOS settings of the controller. The Halt On setting must be set to 

All, But Keyboard for the PXI controller to boot without a 

keyboard connected. You can find the Halt On setting in the Standard 

CMOS Setup options. Refer to your PXI controller user manual for 

more information about BIOS settings.

Why does my PXI controller boot into Windows when I use my PXI 

boot disk?

Check the BIOS setting for the Boot Sequence of your PXI controller. 

The boot sequence for your PXI controller defined in the BIOS settings 

must be set to A,C,... to boot from a floppy disk. If the Boot Sequence 

setting is set to boot from the C:\ drive before the A:\ drive, the controller 

only boots into Windows. You can find the Boot Sequence setting in the 

BIOS Features Setup settings. Refer to your PXI controller user manual 

for more information about BIOS settings.
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What if Windows is not already installed on my PXI controller?

If you ordered your PXI controller separately from your IMAQ Vision for 

LabVIEW RT package, your controller may not have Windows 

pre-installed. Windows is required on your development controller in order 

to configure your camera and acquisition device. Please contact your local 

sales representative to have Windows installed on your PXI controller. 

A complete list of internal offices is included at the back of this manual.

Remote Acquisition Errors

Why am I unable to use the Remote Acquisition Module in IMAQ 

Vision Builder?

Check to make sure that you have IMAQ Vision for LabVIEW RT installed 

on your PXI controller. Refer to Chapter 2, Install and Configure Your 

Development System, for more installation information.

If you experience further problems with the Remote Acquisition Module, 

verify that the following system components are configured correctly:

• Camera Connection—Make sure that your camera is properly 

connected to your IMAQ device. The camera should also be powered 

according to the camera manufacturer’s specifications.

• Remote IP Address—Ensure that the Remote IP address is correct. 

This address is displayed on the Settings tab in MAX as well as on 

your remote system monitor during startup.

• Interface Name—Run the remote IMAQ Hardware Diagnostic utility 

to verify the interface names that are configured on your system. Each 

detected interface should pass the diagnostic tests.

If you continue to receive errors, contact National Instruments Technical 

Support. Technical Support information is available in Appendix B, 

Technical Support and Professional Services.

Configuration Errors

Why does Configure IMAQ RT.exe tell me that it is unable to 

configure my interface?

This error occurs when you specify an interface name that contains more 

than eight characters. 

When you defined your configuration settings in MAX, you saved those 

settings in a file that uses the name of the interface plus the .iid extension. 
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However, because LabVIEW RT only supports files that use the 8.3 naming 

convention, any configuration files that have an interface name longer than 

eight characters are rejected when you try to copy them to the target device 

with Configure IMAQ RT.exe.

To correct this error, launch MAX from your RT target. Load your original 

interface. Right-click on that interface and select Save As. Give the 

interface a new name that uses eight or fewer characters. Once you have 

saved the new configuration file, you must remove the old one. Browse to 

your <ni-imaq>\data directory and delete the old file. You should now 

be able to run Configure IMAQ RT.exe with no errors.

Remote Display Errors

Why am I unable to display remote images?

The IMAQ Vision Remote Server controls the display of images that are 

acquired from your remote systems. If you are unable to display your 

remote images, press <Ctrl-Alt-Del>, which opens the Windows Task 

Manager, and confirm that NIVisSvr.exe is running as an active process. 

If NIVisSvr.exe is not running, close and restart LabVIEW RT and any 

open IMAQ Vision applications.

If you still experience errors, contact National Instruments Technical 

Support. Technical Support information is available in Appendix B, 

Technical Support and Professional Services.

Why does my remotely displayed image have low quality?

Try these steps to improve your image quality:

• Ensure that your camera aperture is open to allow the appropriate 

amount of light for an acquisition.

• Check your compression settings. 

• Make sure that your display settings in Windows are set to use at least 

24-bit color.
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Programming Errors

Why won’t my LabVIEW VI run on my LabVIEW RT target? 

Your IMAQ Vision VI may not be supported under LabVIEW RT. The 

following VIs are among those not supported:

• IMAQ Browser Delete

• IMAQ Browser Focus

• IMAQ Browser Focus Setup

• IMAQ Browser Insert

• IMAQ Browser Replace

• IMAQ Browser Setup

• IMAQ Draw

• IMAQ Draw Text

• IMAQ WindGrid

• Other obsoleted VIs. If your program contains a VI that has been 

updated or replaced to support new functionality, the icon of the 

obsoleted VI will contain a small black X.

If you created a VI in IMAQ Vision Builder, selecting Image File for your 

Image Source setting will cause your VI to return a File Not Found 

error in LabVIEW RT. This is because the File Dialog function is not 

supported in LabVIEW RT. To avoid this error, select Image Control or 

Image Acquisition Board as the Image Source.

How can I make my IMAQ Vision for LabVIEW application work on 

my RT system if it contains IMAQ Draw or IMAQ Draw Text?

IMAQ Draw and IMAQ Draw Text VIs are not supported under LabVIEW 

RT. However, you can achieve similar functionality by using the IMAQ 

Overlay VIs, such as IMAQ Overlay Rectangle and IMAQ Overlay Text. 

You can also use IMAQ Merge Overlay to merge your overlay data into 

your image.

How can I make my IMAQ Vision for LabVIEW application work on 

my RT system if it contains IMAQ Browser VIs?

If your application uses any of the IMAQ Browser VIs, use IMAQ Image 

To Image to embed multiple images within a single image.
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Why do I get the error <IMG_ERR_BINT> (Bad Interface) when I run 

my LabVIEW VI?

Be sure that you have selected your PXI system as your target device. 

A common mistake is to fail to switch your execution target to your remote 

RT device, accidentally running your IMAQ Vision for LabVIEW RT VI 

on your host machine. Since your host machine may not have an image 

acquisition device, LabVIEW RT cannot recognize an interface and sends 

the Bad Interface error.

Why do I get a File Not Found error from my LabVIEW VI when I 

run it on LabVIEW RT?

When you run your LabVIEW RT application, your VI is downloaded to 

your remote PXI controller, but your support files, such as images and 

templates, are not. The File I/O routines in LabVIEW RT and IMAQ Vision 

always refer to files on the target machine, which in this case, is the remote 

RT PXI controller. Use FTP to move your image files to the PXI controller.

For more information about transferring files to your RT PXI controller 

using FTP, refer to your LabVIEW RT documentation.

If you created a VI in IMAQ Vision Builder, selecting Image File for your 

Image Source setting will cause your VI to return a File Not Found 

error in LabVIEW RT. This is because the File Dialog function is not 

supported in LabVIEW RT. To avoid this error, select Image Control or 

Image Acquisition Board as the Image Source.

PXI Video Out Errors

Why do I have an invalid Video Out Mode?

To use the PXI Video Out functionality in IMAQ Vision for LabVIEW RT, 

you must have a PXI controller featuring the i815 graphics chipset. The 

National Instruments PXI 8175/6 Series controllers use this chipset.

If you are using a controller that does not support PXI Video Out, consider 

using Remote Display to display your images.

Why can’t I see my images when I use PXI Video Out?

Use the IMAQ Video Out VI to configure your video mode before you 

attempt to display your images. This VI allows you to set your refresh 

frequency, screen area, and color depth.
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Note If you are using a monitor that does not support high refresh frequencies, your 

images will not display correctly. Consult your monitor documentation for information on 

supported refresh frequencies.

You can also run the Video Setup Example from within LabVIEW 

(Help»Search IMAQ Examples). This example allows you to experiment 

and select the best video mode setting for your application and equipment.
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B
Technical Support and 
Professional Services

Visit the following sections of the National Instruments Web site at 

ni.com for technical support and professional services:

• Support—Online technical support resources include the following:

– Self-Help Resources—For immediate answers and solutions, 

visit our extensive library of technical support resources available 

in English, Japanese, and Spanish at ni.com/support. These 

resources are available for most products at no cost to registered 

users and include software drivers and updates, a KnowledgeBase, 

product manuals, step-by-step troubleshooting wizards, hardware 

schematics and conformity documentation, example code, 

tutorials and application notes, instrument drivers, discussion 

forums, a measurement glossary, and so on.

– Assisted Support Options—Contact NI engineers and other 

measurement and automation professionals by visiting ni.com/

ask. Our online system helps you define your question and 

connects you to the experts by phone, discussion forum, or email.

• Training—Visit ni.com/custed for self-paced tutorials, videos, and 

interactive CDs. You also can register for instructor-led, hands-on 

courses at locations around the world.

• System Integration—If you have time constraints, limited in-house 

technical resources, or other project challenges, NI Alliance Program 

members can help. To learn more, call your local NI office or visit 

ni.com/alliance.

If you searched ni.com and could not find the answers you need, contact 

your local office or NI corporate headquarters. Phone numbers for our 

worldwide offices are listed at the front of this manual. You also can visit 

the Worldwide Offices section of ni.com/niglobal to access the branch 

office Web sites, which provide up-to-date contact information, support 

phone numbers, email addresses, and current events.
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Glossary

Prefix Meaning Value

m- milli- 10–3

k- kilo- 103

A

A/D Analog-to-digital.

acquisition window The image size specific to a video standard or camera resolution.

address Value that identifies a specific location (or series of locations) in memory.

analog camera A camera that transforms light into pixels and then translates each pixel’s 

level of light into an analog video signal.

API Application programming interface.

arithmetic operators The image operations multiply, divide, add, subtract, and remainder.

B

b Bit. One binary digit, either 0 or 1.

B Byte. Eight related bits of data, an eight-bit binary number. Also denotes 

the amount of memory required to store one byte of data.

binary image An image in which the objects usually have a pixel intensity of 1 (or 255) 

and the background has an intensity value of 0.

bit depth The number of bits (n) used to encode the value of a pixel. For a given n, 

a pixel can take 2 n different values. For example, if n equals 8 bits, a pixel 

can take 256 different values ranging from 0 to 255. If n equals 16 bits, a 

pxiel can take 65,536 different values, ranging from 0 to 65,535 or –32,768 

to 32,767.
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blob Binary large object. A connected region or grouping of pixels in an image 

in which all pixels have the same intensity level. Blobs are also referred to 

as objects or particles.

blob analysis A series of processing operations and analysis functions that produce some 

information about the objects in an image.

Builder file IMAQ Vision Builder script file. Builder files are ASCII text files that list 

the processing functions and relevant parameters for an image processing 

algorithm created in IMAQ Vision Builder.

bus A group of conductors that interconnect individual circuitry in a computer, 

such as the PCI bus; typically the expansion vehicle to which I/O or other 

devices are connected.

C

caliper (1) A function in IMAQ Vision Builder that calculates distances, angles, 

circular fits, and the center of mass based on positions given by edge 

detection, particle analysis, centroid, and search functions. 

(2) A measurement function that finds edge pairs along a specified path in 

the image. This function performs an edge extraction and then finds edge 

pairs based on specified criteria such as the distance between the leading 

and trailing edges, edge contrasts, and so forth.

D

DAQ Data acquisition. (1) Collecting and measuring electrical signals from 

sensors, transducers, and test probes or fixtures and inputting them to a 

computer for processing. (2) Collecting and measuring the same kinds of 

electircal signals with A/D or DIO boards plugged into a computer, and 

possibly generating control signals with D/A and/or DIO boards in the 

same computer.

default setting A default parameter value recorded in the driver. In many cases, the default 

input of a control is a certain value (often 0).

determinism Characteristic of a system that describes how reliably it can respond to 

external events, or perform operations, within a given time limit.

device Plug-in data or image acquisition board that can contain multiple channels 

and conversion devices.
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digital camera A camera that transforms light information into pixels and then translates 

each pixel’s level of light into a digital number inside the camera.

DNS Domain Name Server.

driver Software that controls a specific hardware device, such as an IMAQ or 

DAQ device.

E

Ethernet A high-speed local area network (LAN) which conforms to the IEEE 802.3 

standard.

F

ftp File transfer protocol. Protocol based on TCP/IP to exchange files between 

computers.

H

hardware The physical components of a computer system, such as the circuit boards, 

plug-in boards, chassis, enclosures, peripherals, and cables.

host PC The computer on which the LabVIEW RT Development System is used to 

develop and target VIs to RT Series hardware.

I

I/O Input/output. The transfer of data to/from a computer system, incolving 

communications channels, operator interface devices, and/or data 

acquisition and control interfaces.

image processing Encompasses various processes and analysis functions that you can apply 

to an image.

L

lossy compression Compression in which the decompressed image is visually similar but not 

identical to the original image.
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M

MB Megabyte of memory.

O

operating system Base-level software that controls a computer, runs programs, interacts with 

users, and communicates with installed hardware or peripheral devices.

P

pixel depth The number of bits used to represent the gray level of a pixel.

PXI PCI eXtensions for Instrumentation. An open specification that builds on 

the CompactPCI specification by adding instrumentation-specific features.

R

real time A property of an event of a system in which data is processed as it is 

acquired instead of being accumulated and processed at a later time.

RT Series PXI controller National Instruments PXI controller running the RT Engine.

RT Series PXI system National Instruments PXI chassis with an RT Series PXI controller 

installed.

S

signal conditioning The manipulation of signals to prepare them for digitizing.

synchronous Property or operation that begins an operation and returns control to the 

program only when the operation is complete.

T

time-bounded Characterisitic associated with an RT event assuring that the execution time 

of the event or task is predictable.
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V

VI Virtual Instrument. (1) A combination of hardware and/or software 

elements, typically used with a PC, that has the functionality of a classic 

standalone instrument (2) A LabVIEW software module (VI), which 

consists of a front panel user interface and a block diagram program.
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Index

A
acquisition VIs, 5-3

application development, 3-1 to 3-6

acquiring images, 3-2

configuring compression settings, 3-2 to 3-3

creating LabVIEW VI from IMAQ Vision 

Builder script, 3-5

deploying applications, 5-4 to 5-5

launching IMAQ Vision Builder, 3-1 to 3-2

processing images, 3-3 to 3-4

running VI in LabVIEW RT on remote 

target, 3-5 to 3-6

C
camera settings

checking with Measurement & Automation 

Explorer, 2-6 to 2-7

transferring RT configuration settings, 2-8

components of IMAQ Vision for 

LabVIEW RT, 1-5 to 1-9

compression settings, configuring, 3-2 to 3-3

configuration. See installation and configuration.

configuration errors, troubleshooting, 

A-2 to A-3

Configure IMAQ RT.exe, 2-8

conventions used in manual, vii

D
data driven VIs, 5-3

deployed system, 1-3 to 1-4

deploying applications, 5-4 to 5-5

determinism

acquisition VIs, 5-3

data driven VIs, 5-3

definition, 5-1

file I/O and display VIs, 5-3

image size considerations, 5-2

in IMAQ Vision for LabVIEW RT, 

5-1 to 5-3

memory allocation, 5-2

parallel processing, 5-2

developing applications. See application 

development.

development system

installing and configuring. See installation 

and configuration.

National Instruments PXI system, 1-2 to 1-3

Pentium-based host computer, 1-2

display VIs, 5-3

displaying images, 4-1 to 4-3

PXI Video Out, 4-2 to 4-3

Remote Display, 4-1 to 4-2

troubleshooting remote display errors, A-3

documentation

conventions used in manual, vii

related documentation, viii

resources and examples, 1-4 to 1-5

E
errors, troubleshooting. See troubleshooting 

errors.

examples and documentation 

resources, 1-4 to 1-5

external image files, 5-3
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F
file I/O and display VIs, 5-3

H
host computer (Pentium-based)

host and remote system requirements 

(table), 2-2

minimum system requirements, 1-2

setting up, 2-3 to 2-4

creating configuration disk, 2-3

creating PXI boot disk, 2-4

I
image files, external, 5-3

images

acquiring

in IMAQ Vision Builder, 3-2

preparing PXI chassis for image 

acquisition, 2-4 to 2-6

configuring compression settings, 

3-2 to 3-3

displaying, 4-1 to 4-3

PXI Video Out, 4-2 to 4-3

Remote Display, 4-1 to 4-2

processing, 3-3 to 3-4

size considerations, 5-2

IMAQ hardware, testing remotely, 

2-12 to 2-13

IMAQ Vision Builder. See also application 

development.

creating LabVIEW VI from script, 3-5

launching, 3-1 to 3-2

new functionality, 1-9

overview, 1-8

IMAQ Vision for LabVIEW RT

components, 1-5 to 1-9

IMAQ Vision, 1-7 to 1-8

IMAQ Vision Builder, 1-8 to 1-9

National Instruments IMAQ 

devices, 1-5

NI-IMAQ, 1-5 to 1-7

deployment, 5-4 to 5-5

determinism, 5-1 to 5-3

documentation and examples, 1-4 to 1-5

image files, 5-3

new functionality, 1-8

overview, 1-1

system components and 

requirements, 1-1 to 1-4

deployed system, 1-3 to 1-4

development system, 1-2 to 1-3

IMAQ Vision software, 1-7 to 1-8

installation and configuration, 2-1 to 2-13

checking camera settings with 

Measurement & Automation 

Explorer, 2-6 to 2-7

configuring PXI controller as remote 

device, 2-8 to 2-10

host computer

creating configuration disk, 2-3

creating PXI boot disk, 2-4

requirements (table), 2-2

setting up, 2-3

IMAQ device installation, 2-5

preparing PXI chassis for image 

acquisition, 2-4 to 2-6

remotely installing IMAQ Vision for 

LabVIEW RT software, 2-10 to 2-12

remotely testing IMAQ hardware, 

2-12 to 2-13

requirements for getting started, 

2-1 to 2-2

transferring RT configuration 

settings, 2-8

troubleshooting configuration errors, 

A-2 to A-3
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L
LabVIEW VIs. See VIs.

M
manual. See documentation.

Measurement & Automation Explorer, 

2-6 to 2-7

memory allocation in LabVIEW RT, 5-2

N
National Instruments IMAQ devices, 1-5

National Instruments PXI system. See PXI 

controllers.

NI-IMAQ software, 1-5 to 1-7

new functionality in NI-IMAQ for 

LabVIEW RT, 1-7

NI-IMAQ functions, 1-6

P
parallel processing in LabVIEW RT, 5-2

Pentium-based host computer. See host 

computer (Pentium-based).

problems and solutions. See troubleshooting 

errors.

processing images, 3-3 to 3-4

programming errors, troubleshooting, 

A-4 to A-5

PXI boot disk, creating, 2-4

PXI controllers

available controllers (table), 1-3

checking camera settings with 

Measurement & Automation Explorer, 

2-6 to 2-7

configuring as remote device, 2-8 to 2-10

installing IMAQ device, 2-5 to 2-6

minimum system requirements, 1-3

overview of National Instruments PXI 

controllers, 1-2 to 1-3

preparing PXI chassis for image 

acquisition, 2-4 to 2-6

troubleshooting errors, A-1 to A-2

PXI Video Out

overview, 4-2 to 4-3

troubleshooting errors, A-5 to A-6

R
real-time determinism. See determinism.

remote acquisition errors, 

troubleshooting, A-2

remote device, configuring PXI controller as, 

2-8 to 2-10

Remote Display, 4-1 to 4-2

remote display errors, troubleshooting, A-3

remote installation of IMAQ Vision for 

LabVIEW RT software, 2-10 to 2-12

remote testing of IMAQ hardware, 

2-12 to 2-13

requirements for IMAQ Vision for LabVIEW 

RT. See system components and 

requirements.

S
support services from National 

Instruments, B-1

system components and requirements, 

1-1 to 1-4

deployed system, 1-3 to 1-4

development system, 1-2 to 1-3

system integration services from National 

Instruments, B-1
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T
technical support and professional 

services, B-1

training from National Instruments, B-1

transferring RT configuration settings, 2-8

troubleshooting errors, A-1 to A-6

configuration errors, A-2 to A-3

programming errors, A-4 to A-5

PXI controller errors, A-1 to A-2

PXI Video Out errors, A-5 to A-6

remote acquisition errors, A-2

remote display errors, A-3

V
VIs

acquisition VIs, 5-3

data driven VIs, 5-3

file I/O and display VIs, 5-3

LabVIEW VIs

creating from IMAQ Vision Building 

script, 3-5

running in LabVIEW RT on remote 

target, 3-5 to 3-6
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